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Minimum requirements and components
Decipher IDP is a production ready IDP solution, closely integrated with Blue Prism. We recommend that 
you deploy Decipher IDP on dedicated hardware to better support scalability as your use of Decipher IDP 
increases. We also recommend installing and testing Decipher IDP in a non-production environment prior 
to using it in a live environment.

Decipher IDP is designed to provide an on-premise solution and is not supported in Blue Prism Cloud 
at this time.

Minimum requirements

Decipher IDP
The following minimum setup is required to run Decipher IDP on a standalone deployment:

 • Administrator access to the devices on which Blue Prism is installed.
 • CPU: Intel i7 3rd generation or above.
 • Windows 10, or Windows Server 2012 or later.
 • RAM: 6 GB (1 GB for the application server at a load of 10,000 pages per day, plus 3 GB for SQL 

Server, plus 2 GB for Windows).
 • Hard drive space for image storage. The average file size is 1 MB per page and 1 TB per 1 million 

pages.

Natural Language Processing (NLP) Plugin
The NLP plugin is an optional Decipher IDP component and has the following minimum requirements:

 • A graphics card with a Nvidia Graphics Processing Unit (GPU) on it – installed on the same machine 
as the Decipher  automated client.

 • 8 GB of RAM per each GPU.
 • The version of the GPU driver must be 418.0 or later.

Supported browsers
Decipher IDP requires Google Chrome to be set as the default browser. Decipher IDP does not currently 
support any other browsers.

Minimum SQL permissions
The minimum SQL permissions for the user required to connect to the database during the installation 
process must have the appropriate privileges to create or configure the databases from within the product, 
therefore an appropriate administrator account will need to be used when running the installation process:

 • Create Database: dbcreator (server role) or sysadmin (server role)
 • Configure Database: sysadmin (server role) or db_owner (database role)

The database user required to connect to the databases during normal operation must have the minimum 
SQL permissions to access the Decipher IDP databases. The required permissions are:

 • db_datareader
 • db_datawriter

For details on architecture and the projected performance, see the Sizing guide.
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Required components
The following software and database components are required to use Decipher IDP.

Third-party components
The following additional database and software components must be installed before installing Decipher 
IDP. For details of these components, including download links, see Install/configure required software 
components.

 • RabbitMQ and Erlang
 • SQL Server Express 2012 (or later) as a minimum requirement

SQL Server Express is supported for proof of concept and evaluation purposes only. It is not 
recommended or supported for production use.

 • SQL Server Management Studio
 • Internet Information Server (IIS)

Blue Prism and Decipher IDP components

Decipher IDP version 2.1 follows version 1.2. There are no Decipher IDP releases between these 
versions. 

The following components need to be installed and configured for this release of Decipher IDP. Download 
the Decipher IDP components  from the Decipher IDP page on the customer portal. For installation details, 
see Install Blue Prism, Decipher VBO, and DLL and Install Decipher IDP.

Component Filename

Blue Prism BluePrism6.6.0_x64.msi or BluePrism6.6.0_x86.msi or later

Decipher DLL BluePrism.Decipher.VBO.Interop.dll

Blue Prism Decipher VBO BPA Object - Decipher.xml

Decipher Licensing Service Decipher Licensing Service.msi

Decipher Server Decipher Server 2.12.01070.msi

Decipher Web Client Decipher Web Client 2.11.12150.msi

Decipher Automated Clients Decipher Automated Clients 2.11.09201.msi

Server Plugin Decipher Server Plugin.msi

NLP plugin (optional) Decipher NLP Plugin 2.11.11300.msi
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Upgrade Decipher IDP
Blue Prism recommend that customers use the latest version of Decipher IDP. Download the required files 
from the Decipher IDP portal page and update as described below.

Before you upgrade
Blue Prism strongly advise that existing Decipher IDP environments and databases are fully backed up 
prior to upgrade, enabling the restoration of a working environment in the event of a failed installation. The 
backup should be a system or full volume backup and not a backup of specific files within Decipher IDP.

When a Decipher environment is upgraded, all existing data, templates (Data Form Definitions) and 
learning is retained. Once the upgrade is complete, all existing information is retained, but new functions 
and features are now available for use, whether with newly created or existing Data Form Definition files.

Upgrade Decipher IDP 1.2 to 2.1                

Decipher IDP version 2.1 follows version 1.2. There are no Decipher IDP releases between these 
versions. 

To upgrade from Decipher IDP 1.2 to 2.1:

 1. Import the latest Decipher VBO, BPA Object - Decipher.xml, into Blue Prism and overwrite the 
existing VBO.

 2. Paste the BluePrismDecipher.VBO.Interop.dll file into C:\Program Files\Blue Prism Limited\Blue 
Prism Automate, and replace the existing file.

 3. Decipher Licensing Service – Run the Decipher Licensing Service.msi and click through the install 
wizard, following the on-screen instructions as prompted. See Install Decipher licensing service for 
details.

 4. Decipher Server – Run the Decipher Server 2.12.01070.msi and click through the installation 
wizard, following the on-screen instructions as prompted. The installation wizard will display your 
current settings. Click Edit to amend the settings or create a new reporting database (see below for 
details), or click Install to continue. See Install Decipher server for details. 

To create a new, separate reporting database as part of this Decipher IDP upgrade (optional):

 a. Click Edit on the Setup configurations summary screen.

 b. The Configure Server Settings screen displays.
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 c. Select Enable reporting database.
 • If the existing reporting database is on the same server as Decipher Server, but you 

want to create a database on a separate server, deselect Reporting database on same 
server. The Reporting Database Server Configuration screen displays. Add the location 
and credentials for the reporting database server and click Next. 

 d. Click Install to complete the installation, then Finish to exit the wizard.

 5. Decipher Web Client – Run the Decipher Web Client 2.11.12150.msi and click through the install 
wizard, following the on-screen instructions as prompted. See Install Decipher web client for details.

 6. Decipher Automated Clients – Run the Decipher Automated Clients 2.11.09201.msi and click 
through the install wizard. The install wizard will display your current settings. See Install Decipher 
automated clients for details.

When upgrading Decipher Automated Clients, the destination folder and configuration settings 
are grayed out to ensure the  existing installation configuration is retained.

 7. Decipher Server Plugin – Run the Decipher Server Plugin.msi and click through the install wizard. 
The install wizard will display your current settings. See Install Decipher server plugin for details.

After upgrading to the latest version of the Decipher Server Plugin, the previous version will 
need to be manually removed. From the Windows Start menu, open Settings > Apps, select 
the Decipher Server Plugin and click Uninstall. This will be addressed in a future release.

Log locations
Decipher 2.1 introduced new default log locations for the Decipher clients. For details, see Decipher IDP 
2.1 release notes. The log locations for existing installations upgrading to 2.1 will not be changed, but the 
client config files can be manually updated to use the new log location.

Follow the steps below to update the config files for the following clients: OCR, Classification, Capture, 
Export, Web client, Web SDK Service, and SDKWrapper.

 1. Locate and open the config file as an Admin. For details on locations, see Default locations.

 2. In the appSettings section, locate the LogRoot key and set to its value to "%PUBLIC%".
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 3. Save the changes to the config file.
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Upgrade Decipher IDP 1.1 to 2.1 
 To upgrade from Decipher IDP 1.1 to 2.1:

 1. Import the latest Decipher VBO, BPA Object - Decipher.xml, into Blue Prism and overwrite the 
existing VBO.

 2. Paste the BluePrismDecipher.VBO.Interop.dll file into C:\Program Files\Blue Prism Limited\Blue 
Prism Automate, and replace the existing file.

 3. Decipher Licensing Service – Run the Decipher Licensing Service.msi and click through the install 
wizard, following the on-screen instructions as prompted. See Install Decipher licensing service for 
details.

 4. Decipher Server – Run the Decipher Server 2.12.01070.msi and click through the installation 
wizard, following the on-screen instructions as prompted. The installation wizard will display your 
current settings. Click Edit to amend the settings or create a new reporting database (see below for 
details), or click Install to continue. See Install Decipher server for details. 

If required, the separate reporting database must be created when installing/upgrading the 
Decipher Server component.

To create a new, separate reporting database as part of this Decipher IDP upgrade (optional):

 a. Click Edit on the Setup configurations summary screen.

The Configure Server Settings screen displays.
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 b. Select Enable reporting databaseand click Next.

 c. Click Install to complete the installation, then Finish to exit the wizard.

 5. Decipher Web Client – Run the Decipher Web Client 2.11.12150.msi and click through the install 
wizard, following the on-screen instructions as prompted. See Install Decipher web client for details.

 6. Decipher Automated Clients – Run the Decipher Automated Clients 2.11.09201.msi and click 
through the install wizard. The install wizard will display your current settings. See Install Decipher 
automated clients for details.

 7. Decipher Server Plugin –   Run the Decipher Server Plugin.msi and click through the install wizard. 
The install wizard will display your current settings. See Install Decipher server plugin for details.

Following upgrade
The following scenarios should be considered after upgrading Decipher IDP:

Scenario Action

You created a separate reporting 
database as part of the upgrade 
process.

If you need to copy existing reporting data from the Decipher 
database to the new reporting database see Reporting 
database configuration for details.

You bound the Decipher IDP 1.1 
website to HTTPS, via Internet 
Information Services (IIS) Manager.

Check whether the site setting has reverted to HTTP and 
rebind if necessary.

Caching issues are impacting the 
display of DFDs, document types, 
and batch types across multiple 
users.

Clear your browser cache following upgrade. This can be done 
by pressing CTRL + F5.

If you encounter any issues after you have followed every step above and referred to the relevant sections 
of this guide, please see Troubleshooting for further advice.
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Standalone deployment
Follow the steps in this section for a standalone Decipher IDP installation.

Installation is a four-part process for a standalone deployment and must be installed and configured in the 
following order:

Steps
For both standalone and multi-device installations, Decipher IDP must be installed and configured in the 
following order. Each installation step has detailed instructions, or you can follow the relevant installation 
video, where available.

Instructional videos on how to install Decipher IDP and other Blue Prism products are available from: 
https://bpdocs.blueprism.com/en-us/video/installation.htm.

Installation Step Link to instructional video (if 
available)

1. Install and configure third-party software
 • Erlang
 • RabbitMQ
 • SQL Server / SQL Server Express 2012 or later (minimum 

requirement)
 • SQL Server Management Studio (recommend, but not 

required)
 • Internet Information Server (IIS)

 
 • Install Erlang
 • Install RabbitMQ

The RabbitMQ management 
plugin does not need to be 
enabled, or a new user 
configured, for standalone 
deployments.

 • Install IIS

2. Install and configure Blue Prism
 • Install Blue Prism and create a Decipher database
 • Copy the Decipher DLL
 • Import the Decipher VBO - Blue Prism interactive client
 • Import the Decipher processes (release)

 
 • Copy DLL
 • Import VBO

3. Install Decipher IDP
 • Decipher Licensing Service
 • Decipher Server
 • Decipher Web Client
 • Decipher Automated Clients
 • Decipher Server Plugin

 
 • Install Decipher Licensing Service
 • Install Decipher Server
 • Install Decipher Web Client
 • Install Decipher Automated Clients
 • Install Decipher Server Plugin
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Installation Step Link to instructional video (if 
available)

4. Configure Decipher IDP
 • Configure database access

 • Grant system access (NT AUTHORITY) to the Decipher 
database (non-production environments only)

 • Configure Windows Authentication (production 
environments).

 • Secure the Decipher website with a Secure Sockets Layer 
(SSL) (production environments).

 • Add Decipher SQL location to Web.config
 • Check all Decipher services are running
 • Activate Sites and Services for Decipher IDP
 • Enable machine learning training (optional)

 
 • Configure database access  – non-

production environments
 • Configure database access – 

production environments
 • Add Decipher SQL location to 

Web.config
 • Activate Sites and Services for 

Decipher IDP

5. Log onto Decipher IDP
 • You are ready to get started with Decipher IDP

 
 • Log onto Decipher IDP
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Install and configure third-party software
You need to install and configure the following software and settings in the order listed below on a 
dedicated PC before installing Decipher IDP.

Please ensure that you have read the minimum requirements section, including the browser details, 
before installing the third-party software and Decipher IDP components.

Erlang and RabbitMQ
The following components must be installed before installing Decipher IDP:

 • Erlang OTP version 25.1.2
 • RabbitMQ version 3.11.4

Function Erlang and RabbitMQ are required components and must be installed on the machine 
on which the Decipher Web Client will be installed. 

RabbitMQ is installed using a default username and password. These credentials 
are then automatically populated  during the installation of the Decipher licensing 
service. If you do not want to use the default RabbitMQ credentials, you will need 
to amend them before installing Decipher licensing service and enter the new 
credentials during installation.  For details on changing the default credentials, 
see RabbitMQ configuration.

Download The version of Erlang that you require is dependent on the RabbitMQ version you 
intend to use. For more information, see RabbitMQ Erlang Version Requirements.

https://www.erlang.org/downloads

https://www.rabbitmq.com/download.html

Install Run the installers and follow the instructions, accepting the default options when 
prompted. 

SQL Server

Function SQL Server Express 2012  is a minimum database requirement.

SQL Server Express is supported for proof of concept and evaluation purposes 
only. It is not recommended or supported for production use.

Download https://www.microsoft.com/en-us/sql-server/sql-server-downloads

SQL Server Express 2012 (or later) is the minimum requirement for a standalone 
deployment of Decipher IDP.

Supported 
SQL Server 
versions

SQL Server Express 2012, 2016, 2017, 2019

SQL Server 2012, 2014, 2016, 2017, 2019 

Install Run the installer and when prompted, select the basic installation type.
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The Blue Prism Decipher database should not be created at this stage of the 
installation process. See  Create a Blue Prim database for Decipher IDP on 
page 63 for details.

SQL Server Management Studio

Function This is not a requirement for Decipher IDP installation, but is recommended to 
configure and manage components within the SQL server.

For multi-device installations this will need to be installed on a user’s machine only 
where required.

Download https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-
ssms?redirectedfrom=MSDN&view=sql-server-ver15.

Under Download SSMS, click Download SQL Server Management Studio (SSMS) to 
download the SSMS-Setup-ENU.exe.

Install Run the installer and follow the instructions, accepting the default options when 
prompted.

Azure SQL
If using Azure SQL with Decipher IDP, additional configuration is required before installing the Decipher 
IDP components. This includes setting up the database structure and running provided configuration 
scripts. For details, see Configure Azure SQL.
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Internet Information Server (IIS)
IIS needs to be configured on the web server. IIS settings are applied from the Windows control panel: 
Programs > Programs and Features > Turn Windows Features on or off and select Internet Information 
Services.

Ensure the following settings are applied:

IIS Setting Sub Setting

Web Management Tools IIS Management Console

World Wide Web Services Application Development Features
 • .NET Extensibility 3.5
 • .NET Extensibility 4.7
 • ASP .NET 4.7
 • ISAPI Extensions
 • ISAPI Filters

Common HTTP Features
 • Default Document
 • Directory Browsing
 • HTTP Errors
 • Static Content

Health and Diagnostics N/A

Performance Features N/A

Security N/A

Scripted installation
To apply the above settings automatically, run the command below using the PowerShell command 
prompt:

Install-WindowsFeature -Name Web-Mgmt-Console, Web-Net-Ext, Web-Net-Ext45, Web-Asp-Net45, Web-
ISAPI-Ext, Web-ISAPI-Filter, Web-Default-Doc, Web-Dir-Browsing, Web-Http-Errors, Web-Static-
Content -computerName localhost -Restart
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Configure Azure SQL
Decipher IDP supports the use of Azure SQL databases, however some additional configuration is 
required to support this functionality. 

Intended audience
These instructions are intended for database administrators with experience in database management 
and Azure environments. The installation process requires familiarity with installing and configuring 
databases.

Prerequisites
 • DecipherServerDb_Script and DecipherServerDbReporting_Script configuration scripts 

downloaded from the Blue Prism Portal. 

Configuration

The following configuration must be in place before installing Decipher IDP.

To use Azure SQL with Decipher IDP, you must create a master Azure database, add the databases 
required for Decipher IDP, run the provided scripts, insert versioning detail, and create a Blue Prism 
connection.

 1. Create a master Azure database. 

 2. Open Microsoft SQL Server Management Studio and connect to the server that is hosting your 
Azure connection.

 3. To create the Decipher Server database:

 a. In the navigation tree, expand the master database, right-click Databases, and select New 
database from the context menu.

 b. Enter a Database name, and click OK. The default database name is DecipherServerDb. 

 4. Select the new database , create a new query, and run the script named DecipherServerDb_Script.

 5. Create another new query, and insert the text below. Before running, change the UpdateDate value 
to the current date, and ensure the Version column is populated with the relevant value. This should 
be the version number of the Decipher Server.msi, with the first number increased by 7.  For 
example, if using Decipher Server 2.11.10280, the version value should be 9.11.10280. 

INSERT INTO VersionControl (Version, UpdateDate)
                    VALUES ('9.11.10280', '2022-01-10');

 6. If this Decipher IDP installation will use a separate reporting database, repeat steps 2 to 5, but 
change the following details:

 • Database name – The default database name is DecipherServerDbReporting.
 • Script – Run the script named DecipherServerDbReporting_Script.

Create a Blue Prim connection
You need to create a Blue Prism connection to your Azure SQL database.

 1. If you don't already have Blue Prism installed, install and launch Blue Prism.

 2. On the Sign in to Blue Prism screen, click Configure connection. The Connection Configuration 
dialog displays.
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 3. Click New Connection.

 4. On the Connection Configuration screen complete the following details:

Connection Name Enter an easily recognizable name for the connection.

Connection Type Select SQL Server (Windows Authentication).

Database Server Enter the name of the Azure SQL server. 

Database Name Enter a name for the new database, e.g. BluePrism. 

BluePrism is the default database name when 
installing the Decipher licensing service. If you 
create a database using a different name, you 
will need to enter this name when you install the 
Decipher licensing service.

User ID Enter the relevant user ID for the Azure server.

Password Enter the relevant password for the Azure server.

Additional SQL Connection 
Parameters

This is not required.

 5. Click Create Database.

 6. Click OK.

Azure SQL is now ready for use with Decipher IDP and you can proceed with the Decipher IDP installation. 
When specifying SQL connections during the installation of the Decipher IDP components, ensure you 
reference the master Azure database as configured above. For details, see Install Decipher IDP 
components. 
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RabbitMQ configuration
If required, you can amend the default RabbitMQ credentials.

Enable RabbitMQ management plugin
To create enable the RabbitMQ plugin:

 1. From the Start menu, under the RabbitMQ Server folder, select the RabbitMQ Command Prompt 
(sbin dir).

 2. In the RabbitMQ Command Prompt window, type the following command:           
rabbitmq-plugins enable rabbitmq_management

Customize RabbitMQ credentials and set permissions
If you do not want to use the default RabbitMQ credentials, you can create a new user with custom 
credentials, or update the credentials used by the default RabbitMQ user:

 1. Open a  browser and navigate to  http://localhost:15672/.

The RabbitMQ Management login screen displays.

 2. Log into RabbitMQ using guest as both the username and password.

 3. Select the Admin tab and click Add user. 

If you do not want to create a new user, you can also change the username and password of 
the default RabbitMQ user. 

 4. Add the username and password for the user.

 5. In the Tags field, enter administrator.

 6. If adding a new user, click Add user.

Once created, the new user will display in the All users list.
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 7. To grant administrator permissions, in the All users list, select the relevant user. 

The Permissions page for the selected user displays.

 8. In the Set permission dialog, ensure the Virtual Host field contains the / character and do not amend 
the other default parameter settings.

 9. Click Set permission to apply these permissions to the new user.

 10. Run the installers for Decipher Licensing Service and Decipher Server. On the RabbitMQ 
connection configuration screen enter the RabbitMQ credentials as configured above. For details, 
see Install Decipher IDP components.

 11. Run the installers for Decipher Web Client, Decipher Automated Clients, and Decipher Server 
Plugin.

 12. Open the following config files, and in the appSettings node, populate the RabbitMQHost with just 
the hostname or IP address of the RabbitMQ server; and populate  the RabbitMQUsername and 
RabbitMQPassword attributes with the relevant credentials and save the changes.  

Config file Default location

Web.config C:\Program Files (x86)\Blue Prism\Decipher Web

Ssi.SdkService.exe.config C:\Program Files (x86)\BluePrism\Decipher Web SDK Service

Ssi.SdkWrapper.exe.config C:\Program Files (x86)\BluePrism\Decipher Web SDK 
Service\SdkWrapper

Credentials are entered as plain text. For enhanced security, the credentials can be encrypted. 
For more information, see Encrypt credentials on the next page.

 13. Open Internet Information Services (IIS) Manager and select the Decipher website from the 
navigation tree.
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 14. Under Manage Website in the right-hand pane, click Restart.

 15. Using Windows Services, restart RabbitMQ and all Decipher Services (Decipher Licensing Service, 
Decipher Server, Decipher Web Client, and Decipher Automated Clients).

 16. Restart your machine. 

The RabbitMQ user is now set up and ready for use with Decipher IDP. 

Encrypt credentials
As part of this configuration, RabbitMQ credentials are entered as plain text. While the Web.config 
automatically encrypts the credentials after first login, values are kept as plain text in the 
Ssi.SdkService.exe.config and Ssi.SdkWrapper.exe.config files. To be able to encrypt the credentials in all 
the files, the account running the Decipher Web SDK service must have write permissions to the Decipher 
installation folder. The default network service account will not have sufficient permissions. To change the 
account:

 1. From Windows Services, right-click the  Decipher Web SDK service and select Properties.

 2. Click the Log On tab and select This account.

 3. Enter the location and password of the relevant account, and click OK.

 4. In Windows Services, restart the following Decipher services: Decipher Licensing Service, Decipher 
Server, Decipher Web Client, and Decipher Automated Clients.

 5. Log into Decipher IDP.

Upon successful login to Decipher IDP, the credentials are encrypted in  all three config files. If required, 
you can change the service to use the original account after the credentials have been encrypted. 

Update default credentials for existing installations
If required, you can change the default credentials for existing installations:

 1. From the Windows Start menu, open Settings > Apps, select the Decipher Licensing Service and 
click Modify. The Decipher Licensing Service Setup dialog displays.

 2. On the Change, repair, or remove installation screen, click Change. Proceed through the wizard. On 
the RabbitMQ connection configuration screen, enter the new RabbitMQ credentials as configured 
above. 

 3. Uninstall and reinstall Decipher Server. During installation, on the Licensing screen, enter the new 
RabbitMQ credentials.

 4. Open the following config files, and in the appSettings node, populate the RabbitMQHost with just 
the hostname or IP address of the RabbitMQ server; and populate  the RabbitMQUsername and 
RabbitMQPassword attributes with the relevant credentials and save the changes.

Config file Default location

Web.config C:\Program Files (x86)\Blue Prism\Decipher Web

Ssi.SdkService.exe.config C:\Program Files (x86)\BluePrism\Decipher Web SDK Service

Ssi.SdkWrapper.exe.config C:\Program Files (x86)\BluePrism\Decipher Web SDK 
Service\SdkWrapper

Credentials are entered as plain text. For enhanced security, the credentials can be encrypted. 
For more information, see Encrypt credentials above.
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 5. Open Internet Information Services (IIS) Manager and select the Decipher website from the 
navigation tree.

 6. Under Manage Website in the right-hand pane, click Restart.

 7. Using Windows Services, restart RabbitMQ and all Decipher Services (Decipher Licensing Service, 
Decipher Server, Decipher Web Client, and Decipher Automated Clients).

 8. Restart your machine. 

The credentials used for RabbitMQ are now updated and ready for use with Decipher IDP. 
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Install and configure Blue Prism
The following components are required to complete the steps below:

 • Blue Prism
 • Decipher DLL
 • Decipher VBO
 • Decipher v2.1.bprelease

For details of component versions see the release notes.

Install Blue Prism and create a database
If you do not already have Blue Prism installed, you will need to install Blue Prism 6.6 or later. If you 
already have Blue Prism installed you just need to create a Blue Prism database for use with Decipher IDP 
– you will need to reference this when installing the Decipher Licensing Service.

This is an overview of the steps required to install Blue Prism and create a database. You can find  full 
instructions on how to install, configure, and use our product in the Blue Prism help.
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Create a Blue Prim database for Decipher IDP
You need to create a new database for your Decipher IDP data.

 1. Install and launch Blue Prism.

 2. In the Sign in to Blue Prism screen, click Configure connection to launch the configure connection 
wizard.

 3. Click New Connection followed by Create Database.

 4. In the Connection Configuration screen complete the following details:

Connection Name Enter an easily recognizable name for the connection.

Connection Type Select SQL Server (Windows Authentication).

Database Server Enter the network location of the SQL server instance. 
If you have installed SQL Express as described in this 
guide, this will be localhost\SQLExpress.

Database Name Enter a name for the new database, e.g. BluePrism. 

BluePrism is the default database name when 
installing the Decipher licensing service. If you 
create a database using a different name, you 
will need to enter this name when you install the 
Decipher licensing service.

Additional SQL Connection 
Parameters

This is not required.

 5. Select your required user authentication method and click OK to create the database.

Add Decipher IDP license to Blue Prism
You need a Decipher IDP license to run Decipher. This must be added to Blue Prism before installing 
Decipher IDP. 
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 1. Log into Blue Prism.

Ensure that you log into Blue Prism using the connection configured to use the database 
created for Decipher IDP. This is because Decipher licensing will not work unless you apply 
the license key to the Decipher database. You also need to ensure you specify this database 
when installing the Decipher Licensing Service.

 2. Click the System tab and select System > License from the navigation tree. Details of the active 
license are displayed and options are available to install new licenses and remove existing ones. 

 3. Click Install new license to add the Decipher license.
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Add the Decipher DLL
For multi-device installations (any interactive client or runtime resource that will run the Decipher Blue 
Prism processes), this DLL needs to be copied to the Blue Prism install location for all Blue Prism 
interactive clients and runtime resources using Decipher IDP.

Paste the BluePrismDecipher.VBO.Interop.dll file into C:\Program Files\Blue Prism Limited\Blue 
Prism Automate. 

This is the default install location so adjust it if you have used an alternative – just make sure it is in the 
same directory as Automate.exe.
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Import the Decipher VBO
In Blue Prism select File > Import and import the BPA Object - Decipher.xml. This Decipher VBO can also 
be used to create your own processes.
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Import the Decipher release
Import this release into each separate Blue Prism environment that needs to interact with Decipher IDP.

The Decipher v2.1.bprelease contains a number of pre-built processes to help you use Decipher IDP. 

Process Function Details

Decipher - 01 Push 
Documents

Takes documents located in C:\Invoices and 
pushes them to Decipher IDP as a single batch.

Do not include more than 
15 invoices in a batch.

Decipher - 02 
Batches to Verify

Sample process to determine whether there are 
batches in Decipher IDP that require manual 
verification.

This returns True or 
False and can be used to 
build a process to send 
notifications to users.

Decipher - 03 Get 
Verified Documents

Sample process to retrieve verified documents 
from Decipher IDP and put in a Blue Prism work 
queue.

N/A

Decipher - 04 Get 
Decipher Item from 
BP Queue

Takes the document data from Blue Prism work 
queue and pushes data into collection.

N/A

Select File > Import and select the Decipher v2.1.bprelease you downloaded from the portal. The 
processes are added to the Processes\Default folder in Studio. 
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Install Decipher IDP components

Before installing the Decipher IDP components, you will need to apply a valid Decipher IDP license to 
the Decipher database in Blue Prism for Decipher IDP to work. See Decipher IDP licensing for 
details.

The following components are required to complete the Decipher IDP installation and steps below and 
must be installed in this order:

 1. Decipher Licensing Service

 2. Decipher Server 

 3. Decipher Web Client 

 4. Decipher Automated Clients

 5. Decipher Server Plugin

If you have already installed the beta version of Decipher IDP, you will need to use Windows 
Add/Remove Programs to remove all of the (beta) Decipher components from all devices, before 
installing this release. To avoid any issues, please then follow these installation instructions when re-
installing Decipher IDP.

You can download these files from the Decipher IDP product page of our customer portal. You can see the 
component versions for each release in the release notes.

Depending on your current system setup you may need to restart your computer following installation 
before Decipher IDP can be used.

Install Decipher Licensing Service

RabbitMQ is installed using a default username and password. These credentials are then 
automatically populated  during the installation of the Decipher licensing service. If you do not want to 
use the default RabbitMQ credentials, you will need to amend them before installing Decipher 
licensing service and enter the new credentials during installation.  For details on changing the 
default credentials, see RabbitMQ configuration.

For multi-device installations, this needs to be installed on the Decipher Licensing Service.

 1. Run the Decipher Licensing Service installer.

 2. Click through the install wizard, following the on-screen instructions as prompted.
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 3. On the End-User License Agreement screen, read the license agreement and select I accept the 
terms in the License Agreement, if you accept these terms.

 4. On the Destination Folder screen, click Next to accept the default location for Decipher Licensing 
Service or click Change to specify a different location.
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 5. On the Configure SQL connection screen:

 a. Ensure the correct SQL server is specified. If an Azure SQL database is being used, enter the 
relevant Azure database details. 

 b. The Trusted (Windows Authentication) authentication mode is selected by default. This 
setting is recommended for Decipher IDP, but can be changed if required.      

If using SQL Authentication, ensure your SQL password does not start with an equals 
(=) sign as this is not supported and may lead to a corrupted configuration file.

 c. Enter the name of your existing Blue Prism database. The Database name defaults to 
BluePrism. If you have already created a Blue Prism database for Decipher using a different 
name, enter that name in the Database name field.

If you don’t enter the correct Decipher database name during this part of the installation, 
as described above, Decipher IDP will not successfully run.
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 6. On the RabbitMQ connection configuration screen the following details are completed by default:

Host 
name

The hostname of your RabbitMQ server. Commonly in development environments, 
all components are installed on the same server, and therefore the default is 
localhost. For multi-device environments, you will need to enter the name of the 
RabbitMQ server. 

Port Defaults to 5672.

Queue 
name

Defaults to DecipherLicensing.

 7. Click Next to continue. A message displays notifying you that a queue using the name you have 
specified will be created in RabbitMQ. Click Yes to accept, or No if you want to go back and amend 
the name.

 8. On the RabbitMQ connection configuration screen enter the username and password for RabbitMQ. 
The default is guest.

The RabbitMQ username and password entered here must match the RabbitMQ account – the 
default RabbitMQ username and password are guest. For standalone deployments, the default 
credentials are sufficient. If you created a different RabbitMQ user, enter the credentials for the 
new user. You will be prompted to enter these credentials when installing the Decipher server. 

 9. Click Next.

 10. On the Installation Summary screen, click Install to complete the installation, followed by Finish to 
exit the wizard.
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Install Decipher Server

If required, the separate reporting database must be created when installing/upgrading the Decipher 
Server component.

For multi-device installations, this needs to be installed on the Decipher server.

 1. Run the Decipher Server installer.

 2. Click through the install wizard, following the on-screen instructions as prompted.

 3. On the End-User License Agreement screen, read the license agreement and select I accept the 
terms in the License Agreement, if you accept these terms.

 4. On the Destination Folder screen, click Next to accept the default location for Decipher Server or 
click Change to specify a different location.
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 5. On the Licensing screen, enter the following licensing details:
 • Host name – The hostname of your RabbitMQ server. Commonly in development 

environments, all components are installed on the same server, and therefore the default is 
localhost. For multi-device environments, you will need to enter the name of the RabbitMQ 
server.

 • Queue name – The RabbitMQ queue name. The default is DecipherLicensing.
 • Username and Password – The username and password for the RabbitMQ account that you 

entered when installing the Decipher Licensing Service. The default RabbitMQ username and 
passwords are guest, these credentials can only be used for standalone deployments. 

For multi-device deployments, you will need to first create a new RabbitMQ user to 
access to RabbitMQ server remotely, see Create new RabbitMQ user and set 
permissions for details. 
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 6. On the Database Server Configuration screen:

 a. Ensure the correct SQL server is specified. If an Azure SQL database is being used, enter the 
relevant Azure database details. 

If the SQL server is the MSSQLSERVER default instance, enter the machine name or 
localhost. Entering the full name will result in the server not being found. Alternatively, if 
you need to provide a different instance name, enter the machine name or localhost, 
followed by  \ and the instance name.

 b. The Trusted (Windows Authentication) authentication mode is selected by default. This 
setting is recommended for Decipher IDP, but can be changed if required.

 c. Click Test connection to proceed, followed by Next to continue.
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 7. On the Configure Server Settings screen complete the following details:

Server Database 
Name

Enter a new name for the server database, or accept the default 
DecipherServerDb.

Image Storage Path Enter the location in which to store the documents after they have 
been processed. This can be any location, including OneDrive, 
SharePoint, or a local drive. For example C:\Decipher storage.                            

Server TCP Port Accept the default TCP port, or enter a different port number if 
required. You will need to enter this port number when installing the 
Decipher Web Client.

Install as Windows 
Service

This option is selected by default. Do not deselect this option.

Encrypt All Data At 
Rest

Select this option if you want to store all completed documents as 
encrypted files. This is only necessary if the documents being 
processed are confidential.

If enabled, you will need to configure an encryption password. If 
enhanced security is required, enable the Encrypt the password 
option.                                 

Encrypt Configuration Select this option if you want to encrypt the server settings.

Enable reporting 
database

Select this option to create a separate reporting database. A separate 
reporting database enables you to retain report data for much longer. 
This is also required to populate the accuracy and automation rates 
reports.

For details of how to copy any existing reporting data from the 
Decipher database to the new reporting database, see Reporting 
database configuration.

Reporting database 
on same server

If selected, the reporting database will be created on this server. This 
option is selected by default.

If required, the separate reporting database must be created when installing/upgrading the 
Decipher Server component.
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 8. Click Next.

 9. On the Installation Summary screen, click Install to complete the installation, followed by Finish to 
exit the wizard.
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Install Decipher Web Client
For multi-device installations, this needs to be installed on the Decipher web server.

 1. Run the Decipher Web Client executable.

 2. Click through the install wizard, following the on-screen instructions as prompted.

 3. On the End-User License Agreement screen, read the license agreement and select I accept the 
terms in the License Agreement, if you accept these terms.
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 4. On the Configuration screen complete the following details:

Destination 
Folder

Accept the default install location.

Web Site 
Port

Accept the default web site port, or enter a different port number if required.                              

Application 
Server 
IP/URL

This IP address is required when you install the Decipher server.

Port Ensure the same port number entered for Decipher Server is entered here.

Application 
Database 
Connection 
String

Enter the name of the SQL database connection. If you accepted the default 
settings whilst installing Decipher Server, this will be:

Data Source=.\SQLEXPRESS;Initial Catalog=DecipherServerDb;Integrated 
Security=True

If you didn’t accept the default options, this can be found in the 
SsiServer.exe.config file, which is located in C:\Program Files (x86)\Blue 
Prism\Decipher Server by default.

 5. Click OK to save the settings.

 6. Click Install to continue to install Decipher Web Client, which may take several minutes, followed by 
Close to exit the wizard.

Windows security alerts may display for the erl.exe and the epmd.exe. For Decipher IDP to work 
successfully you will need to allow them to communicate over your private networks.
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Install Decipher Automated Clients
For multi-device installations, this needs to be installed on the Decipher clients server.

 1. Run the Decipher Automated Clients installer.

 2. Click through the install wizard, following the on-screen instructions as prompted.

 3. On the End-User License Agreement screen, read the license agreement and select I accept the 
terms in the License Agreement, if you accept these terms.

 4. On the Destination Folder screen, click Next to accept the default location for Decipher Automated 
Clients or click Change to specify a different location.
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 5. On the Custom Setup screen, select the relevant options. 

For standalone deployments, select every option. For multi-device deployments, with multiple 
automated clients, select only the features required for each installation.

 6. On the Decipher Automated Clients Configuration Settings screen complete the following details:

Server IP/URL Ensure the same IP address entered in the Decipher Server is entered 
here. The default IP address is 127.0.0.1.

Port Ensure the same port number entered for Decipher Server and the 
Decipher Web Client is entered here. The default port is 12543.

Username generaluser This is the Decipher user that will run the different 
modules to extract data from a document.

Password user

Encrypt Configuration Select this option to encrypt the Automated Client configuration 
settings.

 7. Click Install to complete the installation, followed by Finish to exit the wizard.
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Install Decipher Server Plugin
For multi-device installations, this needs to be installed on the Decipher server.

 1. Run the Decipher Server Plugin installer.

 2. Click through the install wizard, following the on-screen instructions as prompted.

 3. On the End-User License Agreement screen, read the license agreement and select I accept the 
terms in the License Agreement, if you accept these terms.

 4. On the Destination Folder screen, click Next to accept the default location for Decipher Server 
Plugin or click Change to specify a different location.

 5. Click Install to complete the installation, followed by Finish to exit the wizard.
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Configure Decipher IDP
When you have installed the Blue Prism and Decipher IDP components, you need to complete the 
following configuration steps before you can get started. These should be done in the following order:

 1. Configure database access:
 • Grant system access (NT AUTHORITY) to the Decipher database (non-production 

environments only)
 • Configure Windows Authentication (production environments)

 2. Secure the Decipher website with a Secure Sockets Layer (SSL) (production environments)

 3. Ensure all Decipher services are running

 4. Activate sites and services for Decipher IDP

 5. Enable machine learning training (optional)

 6. Update and encrypt database connection strings (optional)

 7. Reporting database configuration (optional)

Grant system access (NT AUTHORITY) to the Decipher database (non-production 
environments only)

This configuration applies to single-server, non-production environments only.

The Decipher server service runs under the local system account. In order to access the Decipher 
database, this user must be given access to the database. If you don't want to perform this step for the 
current user, you could set Decipher to run as another user who has access to the database. The user 
needs sufficient permissions to create the database and then read and write to it.

To give NT authority access to the Decipher database:

 1. Open Microsoft SQL Server Management Studio and connect to the instance that is hosting your 
Decipher database. If you installed SQL Express, the default for this is .\SQLEXPRESS.

 2. Click Security > Logins and double-click NT AUTHORITY\SYSTEM. 

The Login Properties dialog displays.
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 3. Click User Mapping and select the relevant the check boxes to ensure the user has db_datareader 
and db_datawriter access to the Decipher database and the Decipher reporting database, if 
applicable.

 4. Click OK to save the changes.
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Configure Windows Authentication (production environments)
For production environments, Blue Prism recommends the use of Windows Authentications using service 
accounts. 

The Decipher services and the website application pool must run under the context of a user that has 
access to the relevant databases.

Configure the Decipher services
The following Decipher services must be configured with database access:

Service name Database Required database permissions

Decipher Licensing 
Service

The Blue Prism database to which 
the Decipher license is applied.

db_datawriter / db_datareader

Decipher Server The Decipher database. db_datawriter / db_datareader

Decipher Web SDK The Decipher database. db_datawriter / db_datareader

To configure Windows authentication for each Decipher service listed above:

 1. From Windows Services, right-click the Decipher service and select Properties.

 2. Click the Log On tab and select This account.

 3. Enter the location and password of your service account.

 4. Perform this task for each Decipher service.

 5. Restart the Decipher services.

Grant the service account access to Decipher folders
The service account used to access the Decipher databases also needs access to the following Decipher 
folders:

 • The Decipher Image Storage Path – This location is defined during the Decipher Server installation 
and can be viewed in: C:\Program Files (x86)\Blue Prism\Decipher Server\ 
SsiServer.exe.config under the "ImageStorageRoot" key.

 • The Decipher application files – C:\Program Files (x86)\Blue Prism\
 • The default Decipher logging locations: 

 • C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue Prism\Blue 
Prism

 • C:\Windows\System32\config\systemprofile\AppData\Local\Decipher

 • C:\Windows\System32\config\systemprofile\AppData\Local\Blue Prism

 • The default website folder – C:\inetpub\wwwroot
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Configure the Decipher website identity
The Decipher website identity should be set to an account that has db_datareader and db_datawriter 
access to the Decipher database. The service account that was specified in the Service configuration can 
be used.

To change the application pool identity:

 1. Open Internet Information Services (IIS) Manager.

 2. On the left-hand pane, navigate to Application Pools.

 3. Select Decipher AppPool.

 4. On the right-hand pane, click Advanced Settings. 

The Advanced Settings dialog displays.
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 5. Under Process Model, click Identity.

The … (ellipsis) button displays.

 6. Click the … (ellipsis) button.

The Application Pool Identity dialog displays.

 7. Select Custom Account and click Set.
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 8. Enter the account credentials, as prompted.

 9. Once complete, navigate back to the Application Pools list.

 10. Select Decipher AppPool and click the Recycle button.

Recycling the IIS logs will log the user out of the current Decipher IDP session. If frequent recycling of 
the IIS logs is required, it is recommended that this is scheduled for outside of operating hours.

Secure the Decipher website with a Secure Sockets Layer (SSL) (production 
environments)
To secure your Decipher website to use an SSL certificate:

 1. Open Internet Information Services (IIS) Manager.

 2. On the left-hand pane, expand the Sites node and select Decipher.

 3. Under Edit Site in the right-hand pane, click Bindings.

The Site Bindings dialog displays.

 4. Click Add.

The Add Site Binding dialog displays.

 5. From the Type drop-down, select https.

 6. Add the host name of the Decipher Server to the Host name field.

 7. Select an SSL certificate.

The SSL certificate drop-down is populated with certificates from the personal certificate store 
on the local machine.

 8. Click OK to accept the changes.

 9. Navigate to the Decipher website and click Restart.

Any clients connecting to the Decipher website will have to trust the certificate that you selected in the 
above process. Self-signed certificates will need to be imported onto client machines, but it is more 
advisable to use a certificate from a certificate authority so that it is implicitly trusted by all clients.
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Check all Decipher services are running
Check that the necessary services exist and are running  – you can do this by typing services into the 
Windows search bar and checking these services:

 • Decipher Automated Client Manager
 • Decipher Licensing Service
 • Decipher Server 

This service will not run until the LocalSystem user has been given access to the database; or 
the Decipher Licensing Service has started.

 • Decipher Web SDK Service
 • RabbitMQ

See Troubleshooting if you encounter any issues starting the services.

Decipher IDP 2.1  | Installation and Configuration
Standalone deployment

Commercial in Confidence Page 48 of 104

https://bpdocs.blueprism.com/decipher-2-1/en-us/troubleshooting.htm
https://bpdocs.blueprism.com/decipher-2-1/en-us/troubleshooting.htm


Activate sites and services for Decipher IDP
By default, IIS creates a website on port 80. If you want Decipher IDP to run on port 80, then this default 
web site must be disabled or moved to avoid it conflicting with Decipher. To do this:

 1. Open IIS and click the Sites folder in the Connections panel.

 2. Select Default Web Site and click Stop on the Actions > Manage Website panel.

 3. Select Decipher and click Start or Restart.

See Log on and set up Decipher IDP admin for next steps.

Enable machine learning training (optional)
Machine learning training can be switched on and off in the Decipher IDP user interface via Document 
types. However, it first needs to be configured in the SsiDataCaptureClient.exe.config file.

 1. Using Notepad++, open the SsiDataCaptureClient.exe.config file as an Admin. (The default location 
is C:\Program Files (x86)\Blue Prism\Decipher Automated Clients.)

 2. Find <add key="EnableModelTrainingML" value="false" /> and set the value to true.

 3. Save the changes to the config file. 

 4. Restart the Decipher Server Service.

For information on why machine learning is not enabled by default, see the Decipher IDP frequently asked 
questions.
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Update and encrypt database connection strings (optional)
For enhanced security, you can choose to encrypt your database connection settings. 

Update the connection string

 1. Using Notepad++, open the SsiServer.exe.config file. The default location is C:\Program Files 
(x86)\Blue Prism\Decipher Server\SsiServer.exe.config.

 2. Find connectionString and update the string with the name of the SQL database connection and 
user credentials. 

The existing connection string depends on whether the option to encrypt was selected when 
installing Decipher Server, and how the user was configured. The following are examples of 
typical connection strings:     

 • Data Source=.\SQLEXPRESS; Initial Catalog=DecipherServerDb; Integrated 
Security=True;

 • Data Source=.\SQLEXPRESS; Initial Catalog=DecipherServerDb; User 
Id=myUsername; Password =myPassword;

 • If already encrypted: 
enc:AQAAANCMnd8BFdERjHoAwE/Cl+sBAAAAardddLezc0amPmM328

 3. Save the changes to the config file.

 4. Restart the Decipher Server service.

Encrypt the connection string

 1. Launch the command prompt.

 2. Set the directory to the installation location, for example cd C:\Program Files (x86)\Blue 
Prism\Decipher Server.
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 3. Enter ssiserver -enc and press Enter. 

 4. Restart the Decipher Server service to test if the configuration is successful. If the service does not 
start, follow the Troubleshooting suggestions.

Reporting database configuration (optional)
If you have chosen to create a separate reporting database during the installation of the Decipher server, 
you can then copy across any existing reporting data from the Decipher database to the new reporting 
database.

 1. Using Notepad++, open the SsiServer.exe.config file. The default location is C:\Program Files 
(x86)\Blue Prism\Decipher Server\SsiServer.exe.config.

 2. Find WorkflowConfig and set the SyncOldDataToReportingDatabase value to True.

 3. Save the changes to the config file.

 4. Restart the Decipher Server service.

Restarting the server may take some time while the data is copied across to the reporting 
database.
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Multi-device deployment
This section describes the steps required for a multi-device installation. We recommend planning your 
installation before installing and considering the information below, regarding different server 
configurations and communication between the servers.

Decipher IDP requires the following six different server types, which can exist on separate machines, or be 
combined as required:

 • Blue Prism application server – This is the Blue Prism server and it needs to access SQL Server 
and Decipher server.

 • Decipher licensing server – Should contain the Decipher licensing service and have access to the 
SQL server and an instance of RabbitMQ, either on the web server or a separate installation.

 • Decipher server – Should contain the Decipher server and the Decipher server plugin and have 
access to the SQL server and an instance of RabbitMQ, either on the web server or a separate 
installation.

 • Decipher clients server – Should contain Decipher automated clients and have access to the SQL 
server and the Decipher server.

 • Decipher web server – Should contain the Decipher Web Client, which includes RabbitMQ. It also 
needs to have access to the SQL server and the Decipher server. Every web server must have a 
local copy of RabbitMQ installed.

 • SQL server – Should contain the SQL server database.

Suitable for production and non-production use, a typical deployment contains all components of Decipher 
IDP deployed to separate machines and includes the application server.

Steps
For both standalone and multi-device installations, Decipher IDP must be installed and configured in the 
following order. Each installation step has detailed instructions, or you can follow the relevant installation 
video, where available.

Instructional videos on how to install Decipher IDP and other Blue Prism products are available from: 
https://bpdocs.blueprism.com/en-us/video/installation.htm.

Installation Step Link to instructional video (if 
available)

1. Install and configure third-party software
 • Erlang
 • RabbitMQ
 • SQL Server / SQL Server Express 2012 or later (minimum 

requirement)
 • SQL Server Management Studio (recommend, but not required)
 • Internet Information Server (IIS)

 
 • Install Erlang
 • Install RabbitMQ
 • Install IIS

 

2. Configure Rabbit MQ to allow remote runtime 
resources to push to Decipher IDP
 • Add the Decipher hostname to the RabbitMQ configuration
 • Create a new RabbitMQ user and set permissions

Video not currently available.
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Installation Step Link to instructional video (if 
available)

3. Install and configure Blue Prism
 • Install Blue Prism and create a Decipher database
 • Copy the Decipher DLL – Copy to the Blue Prism install location 

for all Blue Prism interactive clients and runtime resources 
using Decipher IDP

 • Import the Decipher VBO – Import into every Blue Prism 
interactive client that needs to interact with Decipher IDP

 • Import the Decipher processes (release) – Import into every 
Blue Prism interactive client that needs to interact with Decipher 
IDP

 
 • Copy DLL
 • Import VBO

4. Install Decipher IDP
 • Decipher Licensing Service
 • Decipher Server
 • Decipher Web Client
 • Decipher Automated Clients
 • Decipher Server Plugin

 
 • Install Decipher Licensing Service
 • Install Decipher Server
 • Install Decipher Web Client
 • Install Decipher Automated Clients
 • Install Decipher Server Plugin

5. Configure Decipher IDP
 • Configure database access

 • Grant system access (NT AUTHORITY) to the Decipher 
database (non-production environments only).

 • Configure Windows Authentication (production 
environments).

 • Secure the Decipher website with a Secure Sockets Layer (SSL) 
(production environments).

 • Add Decipher SQL location to Web.config
 • Check all Decipher services are running
 • Activate Sites and Services for Decipher IDP – Update for all 

web servers
 • Enable machine learning training (optional)

 
 • Configure database access  – non-

production environments
 • Configure database access– 

production environments
 • Add Decipher SQL location to 

Web.config
 • Activate Sites and Services for 

Decipher IDP

6. Configure RabbitMQ on Decipher Server
This step is only required for multi-device deployments, where 
Decipher Server and the Decipher Server Plugin are installed on a 
server that is remote from the Decipher Web Server

Video not currently available.

5. Log onto Decipher IDP
 • You are ready to get started with Decipher IDP

 
 • Log onto Decipher IDP
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Install and configure third-party software
You need to install and configure the following software and settings in the order listed below on a 
dedicated PC before installing Decipher IDP.

Please ensure that you have read the minimum requirements section, including the browser details, 
before installing the third-party software and Decipher IDP components.

Erlang and RabbitMQ
The following components must be installed before installing Decipher IDP:

 • Erlang OTP version 25.1.2
 • RabbitMQ version 3.11.4

Function Erlang and RabbitMQ are required components and must be installed on the machine 
on which the Decipher Web Client will be installed. 

RabbitMQ is installed using a default username and password. These credentials 
are then automatically populated  during the installation of the Decipher licensing 
service. If you do not want to use the default RabbitMQ credentials, you will need 
to amend them before installing Decipher licensing service and enter the new 
credentials during installation.  For details on changing the default credentials, 
see RabbitMQ configuration.

Download The version of Erlang that you require is dependent on the RabbitMQ version you 
intend to use. For more information, see RabbitMQ Erlang Version Requirements.

https://www.erlang.org/downloads

https://www.rabbitmq.com/download.html

Install Run the installers and follow the instructions, accepting the default options when 
prompted. 

SQL Server

Function SQL Server Express 2012  is a minimum database requirement.

SQL Server Express is supported for proof of concept and evaluation purposes 
only. It is not recommended or supported for production use.

Download https://www.microsoft.com/en-us/sql-server/sql-server-downloads

SQL Server Express 2012 (or later) is the minimum requirement for a standalone 
deployment of Decipher IDP.

Supported 
SQL Server 
versions

SQL Server Express 2012, 2016, 2017, 2019

SQL Server 2012, 2014, 2016, 2017, 2019 

Install Run the installer and when prompted, select the basic installation type.
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The Blue Prism Decipher database should not be created at this stage of the 
installation process. See  Create a Blue Prim database for Decipher IDP on 
page 63 for details.

SQL Server Management Studio

Function This is not a requirement for Decipher IDP installation, but is recommended to 
configure and manage components within the SQL server.

For multi-device installations this will need to be installed on a user’s machine only 
where required.

Download https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-
ssms?redirectedfrom=MSDN&view=sql-server-ver15.

Under Download SSMS, click Download SQL Server Management Studio (SSMS) to 
download the SSMS-Setup-ENU.exe.

Install Run the installer and follow the instructions, accepting the default options when 
prompted.

Azure SQL
If using Azure SQL with Decipher IDP, additional configuration is required before installing the Decipher 
IDP components. This includes setting up the database structure and running provided configuration 
scripts. For details, see Configure Azure SQL.

Decipher IDP 2.1  | Installation and Configuration
Multi-device deployment

Commercial in Confidence Page 55 of 104

https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?redirectedfrom=MSDN&view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/ssms/download-sql-server-management-studio-ssms?redirectedfrom=MSDN&view=sql-server-ver15


Internet Information Server (IIS)
IIS needs to be configured on the web server. IIS settings are applied from the Windows control panel: 
Programs > Programs and Features > Turn Windows Features on or off and select Internet Information 
Services.

Ensure the following settings are applied:

IIS Setting Sub Setting

Web Management Tools IIS Management Console

World Wide Web Services Application Development Features
 • .NET Extensibility 3.5
 • .NET Extensibility 4.7
 • ASP .NET 4.7
 • ISAPI Extensions
 • ISAPI Filters

Common HTTP Features
 • Default Document
 • Directory Browsing
 • HTTP Errors
 • Static Content

Health and Diagnostics N/A

Performance Features N/A

Security N/A

Scripted installation
To apply the above settings automatically, run the command below using the PowerShell command 
prompt:

Install-WindowsFeature -Name Web-Mgmt-Console, Web-Net-Ext, Web-Net-Ext45, Web-Asp-Net45, Web-
ISAPI-Ext, Web-ISAPI-Filter, Web-Default-Doc, Web-Dir-Browsing, Web-Http-Errors, Web-Static-
Content -computerName localhost -Restart
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Configure Azure SQL
Decipher IDP supports the use of Azure SQL databases, however some additional configuration is 
required to support this functionality. 

Intended audience
These instructions are intended for database administrators with experience in database management 
and Azure environments. The installation process requires familiarity with installing and configuring 
databases.

Prerequisites
 • DecipherServerDb_Script and DecipherServerDbReporting_Script configuration scripts 

downloaded from the Blue Prism Portal. 

Configuration

The following configuration must be in place before installing Decipher IDP.

To use Azure SQL with Decipher IDP, you must create a master Azure database, add the databases 
required for Decipher IDP, run the provided scripts, insert versioning detail, and create a Blue Prism 
connection.

 1. Create a master Azure database. 

 2. Open Microsoft SQL Server Management Studio and connect to the server that is hosting your 
Azure connection.

 3. To create the Decipher Server database:

 a. In the navigation tree, expand the master database, right-click Databases, and select New 
database from the context menu.

 b. Enter a Database name, and click OK. The default database name is DecipherServerDb. 

 4. Select the new database , create a new query, and run the script named DecipherServerDb_Script.

 5. Create another new query, and insert the text below. Before running, change the UpdateDate value 
to the current date, and ensure the Version column is populated with the relevant value. This should 
be the version number of the Decipher Server.msi, with the first number increased by 7.  For 
example, if using Decipher Server 2.11.10280, the version value should be 9.11.10280. 

INSERT INTO VersionControl (Version, UpdateDate)
                    VALUES ('9.11.10280', '2022-01-10');

 6. If this Decipher IDP installation will use a separate reporting database, repeat steps 2 to 5, but 
change the following details:

 • Database name – The default database name is DecipherServerDbReporting.
 • Script – Run the script named DecipherServerDbReporting_Script.

Create a Blue Prim connection
You need to create a Blue Prism connection to your Azure SQL database.

 1. If you don't already have Blue Prism installed, install and launch Blue Prism.

 2. On the Sign in to Blue Prism screen, click Configure connection. The Connection Configuration 
dialog displays.

Decipher IDP 2.1  | Installation and Configuration
Multi-device deployment

Commercial in Confidence Page 57 of 104

https://portal.blueprism.com/products/decipher


 3. Click New Connection.

 4. On the Connection Configuration screen complete the following details:

Connection Name Enter an easily recognizable name for the connection.

Connection Type Select SQL Server (Windows Authentication).

Database Server Enter the name of the Azure SQL server. 

Database Name Enter a name for the new database, e.g. BluePrism. 

BluePrism is the default database name when 
installing the Decipher licensing service. If you 
create a database using a different name, you 
will need to enter this name when you install the 
Decipher licensing service.

User ID Enter the relevant user ID for the Azure server.

Password Enter the relevant password for the Azure server.

Additional SQL Connection 
Parameters

This is not required.

 5. Click Create Database.

 6. Click OK.

Azure SQL is now ready for use with Decipher IDP and you can proceed with the Decipher IDP installation. 
When specifying SQL connections during the installation of the Decipher IDP components, ensure you 
reference the master Azure database as configured above. For details, see Install Decipher IDP 
components. 
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RabbitMQ configuration
The following information applies to multi-device configurations using RabbitMQ.

Configure RabbitMQ for remote runtime resources
In multi-device deployments, runtime resources will not be able to push documents to Decipher IDP unless 
RabbitMQ has been configured to respond to the Decipher Server hostname as well as the localhost.

The following sections describe how to configure RabbitMQ to respond to the remote Decipher Server 
hostname, and how to create a RabbitMQ user so that runtime resources can access RabbitMQ remotely.

Add the Decipher hostname to the RabbitMQ configuration
To edit the advanced.config file:

 1. Navigate to the RabbitMQ application folder. The default location is: 
C:/Users/<username>/AppData/Roaming/RabbitMQ

 2. Open advanced.config with a text editor.

 3. Replace the existing content with the following:
[{rabbit, [
{tcp_listeners, [{"<hostname>",5672},{"0.0.0.0",5672}]}
]
}
].

 4. Replace <hostname> with the hostname of the Decipher Web Client machine hosting RabbitMQ and 
save your changes.

 5. Restart the server on which the Decipher Server component is installed and the server on which 
RabbitMQ is installed, if different.

Port 5672, added to the RabbitMQ configuration described above, is the default port used to connect 
to the RabbitMQbroker. Port 15672, used when creating a new RabbitMQ user, is a different port 
used to connect the management console add on.

Create a new RabbitMQ user and set permissions 
To create a new RabbitMQ user to access the RabbitMQ server remotely:

 1. Open a  browser and navigate to  http://localhost:15672/.

The RabbitMQ Management login screen displays.

 2. Log into RabbitMQ using guest as both the username and password.
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 3. Select the Admin tab and click Add user. 

 4. Add credentials for a new user for use with Decipher Server.

 5. In the Tags field, enter administrator.

 6. Click Add user.

Once created, the new user will display in the All users list.
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 7. To grant administrator permissions to the new user, in the All users list, select the user you have just 
created. The Permissions page for the selected user displays.

 8. In the Set permission dialog, ensure the Virtual Host field contains the / character, and do not 
amend the other default parameter settings.

 9. Click Set permission to apply these permissions to the new user.

RabbitMQ will now respond to the Decipher Server hostname, enabling remote runtime resources to push 
to Decipher IDP.
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Install and configure Blue Prism
The following components are required to complete the steps below:

 • Blue Prism
 • Decipher DLL
 • Decipher VBO
 • Decipher v2.1.bprelease

For details of component versions see the release notes.

Install Blue Prism and create a database
If you do not already have Blue Prism installed, you will need to install Blue Prism 6.6 or later. If you 
already have Blue Prism installed you just need to create a Blue Prism database for use with Decipher IDP 
– you will need to reference this when installing the Decipher Licensing Service.

This is an overview of the steps required to install Blue Prism and create a database. You can find  full 
instructions on how to install, configure, and use our product in the Blue Prism help.
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Create a Blue Prim database for Decipher IDP
You need to create a new database for your Decipher IDP data.

 1. Install and launch Blue Prism.

 2. In the Sign in to Blue Prism screen, click Configure connection to launch the configure connection 
wizard.

 3. Click New Connection followed by Create Database.

 4. In the Connection Configuration screen complete the following details:

Connection Name Enter an easily recognizable name for the connection.

Connection Type Select SQL Server (Windows Authentication).

Database Server Enter the network location of the SQL server instance. 
If you have installed SQL Express as described in this 
guide, this will be localhost\SQLExpress.

Database Name Enter a name for the new database, e.g. BluePrism. 

BluePrism is the default database name when 
installing the Decipher licensing service. If you 
create a database using a different name, you 
will need to enter this name when you install the 
Decipher licensing service.

Additional SQL Connection 
Parameters

This is not required.

 5. Select your required user authentication method and click OK to create the database.

Add Decipher IDP license to Blue Prism
You need a Decipher IDP license to run Decipher. This must be added to Blue Prism before installing 
Decipher IDP. 
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 1. Log into Blue Prism.

Ensure that you log into Blue Prism using the connection configured to use the database 
created for Decipher IDP. This is because Decipher licensing will not work unless you apply 
the license key to the Decipher database. You also need to ensure you specify this database 
when installing the Decipher Licensing Service.

 2. Click the System tab and select System > License from the navigation tree. Details of the active 
license are displayed and options are available to install new licenses and remove existing ones. 

 3. Click Install new license to add the Decipher license.
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Add the Decipher DLL
For multi-device installations (any interactive client or runtime resource that will run the Decipher Blue 
Prism processes), this DLL needs to be copied to the Blue Prism install location for all Blue Prism 
interactive clients and runtime resources using Decipher IDP.

Paste the BluePrismDecipher.VBO.Interop.dll file into C:\Program Files\Blue Prism Limited\Blue 
Prism Automate. 

This is the default install location so adjust it if you have used an alternative – just make sure it is in the 
same directory as Automate.exe.
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Import the Decipher VBO
In Blue Prism select File > Import and import the BPA Object - Decipher.xml. This Decipher VBO can also 
be used to create your own processes.
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Import the Decipher release
Import this release into each separate Blue Prism environment that needs to interact with Decipher IDP.

The Decipher v2.1.bprelease contains a number of pre-built processes to help you use Decipher IDP. 

Process Function Details

Decipher - 01 Push 
Documents

Takes documents located in C:\Invoices and 
pushes them to Decipher IDP as a single batch.

Do not include more than 
15 invoices in a batch.

Decipher - 02 
Batches to Verify

Sample process to determine whether there are 
batches in Decipher IDP that require manual 
verification.

This returns True or 
False and can be used to 
build a process to send 
notifications to users.

Decipher - 03 Get 
Verified Documents

Sample process to retrieve verified documents 
from Decipher IDP and put in a Blue Prism work 
queue.

N/A

Decipher - 04 Get 
Decipher Item from 
BP Queue

Takes the document data from Blue Prism work 
queue and pushes data into collection.

N/A

Select File > Import and select the Decipher v2.1.bprelease you downloaded from the portal. The 
processes are added to the Processes\Default folder in Studio. 

Decipher IDP 2.1  | Installation and Configuration
Multi-device deployment

Commercial in Confidence Page 67 of 104



Install Decipher IDP components

Before installing the Decipher IDP components, you will need to apply a valid Decipher IDP license to 
the Decipher database in Blue Prism for Decipher IDP to work. See Decipher IDP licensing for 
details.

The following components are required to complete the Decipher IDP installation and steps below and 
must be installed in this order:

 1. Decipher Licensing Service

 2. Decipher Server 

 3. Decipher Web Client 

 4. Decipher Automated Clients

 5. Decipher Server Plugin

If you have already installed the beta version of Decipher IDP, you will need to use Windows 
Add/Remove Programs to remove all of the (beta) Decipher components from all devices, before 
installing this release. To avoid any issues, please then follow these installation instructions when re-
installing Decipher IDP.

You can download these files from the Decipher IDP product page of our customer portal. You can see the 
component versions for each release in the release notes.

Depending on your current system setup you may need to restart your computer following installation 
before Decipher IDP can be used.

Install Decipher Licensing Service

RabbitMQ is installed using a default username and password. These credentials are then 
automatically populated  during the installation of the Decipher licensing service. If you do not want to 
use the default RabbitMQ credentials, you will need to amend them before installing Decipher 
licensing service and enter the new credentials during installation.  For details on changing the 
default credentials, see RabbitMQ configuration.

For multi-device installations, this needs to be installed on the Decipher Licensing Service.

 1. Run the Decipher Licensing Service installer.

 2. Click through the install wizard, following the on-screen instructions as prompted.
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 3. On the End-User License Agreement screen, read the license agreement and select I accept the 
terms in the License Agreement, if you accept these terms.

 4. On the Destination Folder screen, click Next to accept the default location for Decipher Licensing 
Service or click Change to specify a different location.
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 5. On the Configure SQL connection screen:

 a. Ensure the correct SQL server is specified. If an Azure SQL database is being used, enter the 
relevant Azure database details. 

 b. The Trusted (Windows Authentication) authentication mode is selected by default. This 
setting is recommended for Decipher IDP, but can be changed if required.      

If using SQL Authentication, ensure your SQL password does not start with an equals 
(=) sign as this is not supported and may lead to a corrupted configuration file.

 c. Enter the name of your existing Blue Prism database. The Database name defaults to 
BluePrism. If you have already created a Blue Prism database for Decipher using a different 
name, enter that name in the Database name field.

If you don’t enter the correct Decipher database name during this part of the installation, 
as described above, Decipher IDP will not successfully run.
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 6. On the RabbitMQ connection configuration screen the following details are completed by default:

Host 
name

The hostname of your RabbitMQ server. Commonly in development environments, 
all components are installed on the same server, and therefore the default is 
localhost. For multi-device environments, you will need to enter the name of the 
RabbitMQ server. 

Port Defaults to 5672.

Queue 
name

Defaults to DecipherLicensing.

 7. Click Next to continue. A message displays notifying you that a queue using the name you have 
specified will be created in RabbitMQ. Click Yes to accept, or No if you want to go back and amend 
the name.

 8. On the RabbitMQ connection configuration screen enter the username and password for RabbitMQ. 
The default is guest.

The RabbitMQ username and password entered here must match the RabbitMQ account – the 
default RabbitMQ username and password are guest. For standalone deployments, the default 
credentials are sufficient. If you created a different RabbitMQ user, enter the credentials for the 
new user. You will be prompted to enter these credentials when installing the Decipher server. 

 9. Click Next.

 10. On the Installation Summary screen, click Install to complete the installation, followed by Finish to 
exit the wizard.
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Install Decipher Server

If required, the separate reporting database must be created when installing/upgrading the Decipher 
Server component.

For multi-device installations, this needs to be installed on the Decipher server.

 1. Run the Decipher Server installer.

 2. Click through the install wizard, following the on-screen instructions as prompted.

 3. On the End-User License Agreement screen, read the license agreement and select I accept the 
terms in the License Agreement, if you accept these terms.

 4. On the Destination Folder screen, click Next to accept the default location for Decipher Server or 
click Change to specify a different location.
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 5. On the Licensing screen, enter the following licensing details:
 • Host name – The hostname of your RabbitMQ server. Commonly in development 

environments, all components are installed on the same server, and therefore the default is 
localhost. For multi-device environments, you will need to enter the name of the RabbitMQ 
server.

 • Queue name – The RabbitMQ queue name. The default is DecipherLicensing.
 • Username and Password – The username and password for the RabbitMQ account that you 

entered when installing the Decipher Licensing Service. The default RabbitMQ username and 
passwords are guest, these credentials can only be used for standalone deployments. 

For multi-device deployments, you will need to first create a new RabbitMQ user to 
access to RabbitMQ server remotely, see Create new RabbitMQ user and set 
permissions for details. 
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 6. On the Database Server Configuration screen:

 a. Ensure the correct SQL server is specified. If an Azure SQL database is being used, enter the 
relevant Azure database details. 

If the SQL server is the MSSQLSERVER default instance, enter the machine name or 
localhost. Entering the full name will result in the server not being found. Alternatively, if 
you need to provide a different instance name, enter the machine name or localhost, 
followed by  \ and the instance name.

 b. The Trusted (Windows Authentication) authentication mode is selected by default. This 
setting is recommended for Decipher IDP, but can be changed if required.

 c. Click Test connection to proceed, followed by Next to continue.
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 7. On the Configure Server Settings screen complete the following details:

Server Database 
Name

Enter a new name for the server database, or accept the default 
DecipherServerDb.

Image Storage Path Enter the location in which to store the documents after they have 
been processed. This can be any location, including OneDrive, 
SharePoint, or a local drive. For example C:\Decipher storage.                            

Server TCP Port Accept the default TCP port, or enter a different port number if 
required. You will need to enter this port number when installing the 
Decipher Web Client.

Install as Windows 
Service

This option is selected by default. Do not deselect this option.

Encrypt All Data At 
Rest

Select this option if you want to store all completed documents as 
encrypted files. This is only necessary if the documents being 
processed are confidential.

If enabled, you will need to configure an encryption password. If 
enhanced security is required, enable the Encrypt the password 
option.                                 

Encrypt Configuration Select this option if you want to encrypt the server settings.

Enable reporting 
database

Select this option to create a separate reporting database. A separate 
reporting database enables you to retain report data for much longer. 
This is also required to populate the accuracy and automation rates 
reports.

For details of how to copy any existing reporting data from the 
Decipher database to the new reporting database, see Reporting 
database configuration.

Reporting database 
on same server

If selected, the reporting database will be created on this server. This 
option is selected by default.

If required, the separate reporting database must be created when installing/upgrading the 
Decipher Server component.
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 8. Click Next.

 9. On the Installation Summary screen, click Install to complete the installation, followed by Finish to 
exit the wizard.
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Install Decipher Web Client
For multi-device installations, this needs to be installed on the Decipher web server.

 1. Run the Decipher Web Client executable.

 2. Click through the install wizard, following the on-screen instructions as prompted.

 3. On the End-User License Agreement screen, read the license agreement and select I accept the 
terms in the License Agreement, if you accept these terms.
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 4. On the Configuration screen complete the following details:

Destination 
Folder

Accept the default install location.

Web Site 
Port

Accept the default web site port, or enter a different port number if required.                              

Application 
Server 
IP/URL

This IP address is required when you install the Decipher server.

Port Ensure the same port number entered for Decipher Server is entered here.

Application 
Database 
Connection 
String

Enter the name of the SQL database connection. If you accepted the default 
settings whilst installing Decipher Server, this will be:

Data Source=.\SQLEXPRESS;Initial Catalog=DecipherServerDb;Integrated 
Security=True

If you didn’t accept the default options, this can be found in the 
SsiServer.exe.config file, which is located in C:\Program Files (x86)\Blue 
Prism\Decipher Server by default.

 5. Click OK to save the settings.

 6. Click Install to continue to install Decipher Web Client, which may take several minutes, followed by 
Close to exit the wizard.

Windows security alerts may display for the erl.exe and the epmd.exe. For Decipher IDP to work 
successfully you will need to allow them to communicate over your private networks.
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Install Decipher Automated Clients
For multi-device installations, this needs to be installed on the Decipher clients server.

 1. Run the Decipher Automated Clients installer.

 2. Click through the install wizard, following the on-screen instructions as prompted.

 3. On the End-User License Agreement screen, read the license agreement and select I accept the 
terms in the License Agreement, if you accept these terms.

 4. On the Destination Folder screen, click Next to accept the default location for Decipher Automated 
Clients or click Change to specify a different location.
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 5. On the Custom Setup screen, select the relevant options. 

For standalone deployments, select every option. For multi-device deployments, with multiple 
automated clients, select only the features required for each installation.

 6. On the Decipher Automated Clients Configuration Settings screen complete the following details:

Server IP/URL Ensure the same IP address entered in the Decipher Server is entered 
here. The default IP address is 127.0.0.1.

Port Ensure the same port number entered for Decipher Server and the 
Decipher Web Client is entered here. The default port is 12543.

Username generaluser This is the Decipher user that will run the different 
modules to extract data from a document.

Password user

Encrypt Configuration Select this option to encrypt the Automated Client configuration 
settings.

 7. Click Install to complete the installation, followed by Finish to exit the wizard.
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Install Decipher Server Plugin
For multi-device installations, this needs to be installed on the Decipher server.

 1. Run the Decipher Server Plugin installer.

 2. Click through the install wizard, following the on-screen instructions as prompted.

 3. On the End-User License Agreement screen, read the license agreement and select I accept the 
terms in the License Agreement, if you accept these terms.

 4. On the Destination Folder screen, click Next to accept the default location for Decipher Server 
Plugin or click Change to specify a different location.

 5. Click Install to complete the installation, followed by Finish to exit the wizard.
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RabbitMQ configuration on Decipher Server
In multi-device deployments, where Decipher Server and the Decipher Server Plugin are installed on a 
server that is remote from the Decipher Web Server, you may need to manually install and configure 
RabbitMQ (and Erlang) on that server for the Blue Prism Server Plugin feature to operate. 

The RabbitMQ host name and the Decipher Web Client host name must be the same. If you amend 
the default RabbitMQ host name, you must also update the Decipher Web Client host name. It will 
not update automatically and will result in Decipher IDP not working as expected.

The DecipherServerConfiguration.exe application, which is available to download from the customer 
portal, has been created by Blue Prism  to enable you to modify the configuration and authentication details 
of the RabbitMQ instance on the Decipher Server.

Modify  the RabbitMQ instance on the Decipher Server

 1. Run the DecipherServerConfigurator.exe.

 2. In the Decipher Server configuration file path field, enter the location of the SsiServer.exe.config 
file. If required, use the  Browse... option to change the file path.

 3. Click Open. The default local host endpoints and authentication details for RabbitMQ display.                    
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 4. Update the RabbitMQ endpoint, RabbitMQ username, and RabbitMQ password fields with the 
details specific to your RabbitMQ server. For example:

 5. Click Apply. The tool will validate and update the SsiServer.exe.config with the amended details.
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Configure Decipher IDP
When you have installed the Blue Prism and Decipher IDP components, you need to complete the 
following configuration steps before you can get started. These should be done in the following order:

 1. Configure database access:
 • Grant system access (NT AUTHORITY) to the Decipher database (non-production 

environments only)
 • Configure Windows Authentication (production environments)

 2. Secure the Decipher website with a Secure Sockets Layer (SSL) (production environments)

 3. Ensure all Decipher services are running

 4. Activate sites and services for Decipher IDP

 5. Enable machine learning training (optional)

 6. Update and encrypt database connection strings (optional)

 7. Reporting database configuration (optional)

Grant system access (NT AUTHORITY) to the Decipher database (non-production 
environments only)

This configuration applies to single-server, non-production environments only.

The Decipher server service runs under the local system account. In order to access the Decipher 
database, this user must be given access to the database. If you don't want to perform this step for the 
current user, you could set Decipher to run as another user who has access to the database. The user 
needs sufficient permissions to create the database and then read and write to it.

To give NT authority access to the Decipher database:

 1. Open Microsoft SQL Server Management Studio and connect to the instance that is hosting your 
Decipher database. If you installed SQL Express, the default for this is .\SQLEXPRESS.

 2. Click Security > Logins and double-click NT AUTHORITY\SYSTEM. 

The Login Properties dialog displays.
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 3. Click User Mapping and select the relevant the check boxes to ensure the user has db_datareader 
and db_datawriter access to the Decipher database and the Decipher reporting database, if 
applicable.

 4. Click OK to save the changes.
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Configure Windows Authentication (production environments)
For production environments, Blue Prism recommends the use of Windows Authentications using service 
accounts. 

The Decipher services and the website application pool must run under the context of a user that has 
access to the relevant databases.

Configure the Decipher services
The following Decipher services must be configured with database access:

Service name Database Required database permissions

Decipher Licensing 
Service

The Blue Prism database to which 
the Decipher license is applied.

db_datawriter / db_datareader

Decipher Server The Decipher database. db_datawriter / db_datareader

Decipher Web SDK The Decipher database. db_datawriter / db_datareader

To configure Windows authentication for each Decipher service listed above:

 1. From Windows Services, right-click the Decipher service and select Properties.

 2. Click the Log On tab and select This account.

 3. Enter the location and password of your service account.

 4. Perform this task for each Decipher service.

 5. Restart the Decipher services.

Grant the service account access to Decipher folders
The service account used to access the Decipher databases also needs access to the following Decipher 
folders:

 • The Decipher Image Storage Path – This location is defined during the Decipher Server installation 
and can be viewed in: C:\Program Files (x86)\Blue Prism\Decipher Server\ 
SsiServer.exe.config under the "ImageStorageRoot" key.

 • The Decipher application files – C:\Program Files (x86)\Blue Prism\
 • The default Decipher logging locations: 

 • C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue Prism\Blue 
Prism

 • C:\Windows\System32\config\systemprofile\AppData\Local\Decipher

 • C:\Windows\System32\config\systemprofile\AppData\Local\Blue Prism

 • The default website folder – C:\inetpub\wwwroot
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Configure the Decipher website identity
The Decipher website identity should be set to an account that has db_datareader and db_datawriter 
access to the Decipher database. The service account that was specified in the Service configuration can 
be used.

To change the application pool identity:

 1. Open Internet Information Services (IIS) Manager.

 2. On the left-hand pane, navigate to Application Pools.

 3. Select Decipher AppPool.

 4. On the right-hand pane, click Advanced Settings. 

The Advanced Settings dialog displays.
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 5. Under Process Model, click Identity.

The … (ellipsis) button displays.

 6. Click the … (ellipsis) button.

The Application Pool Identity dialog displays.

 7. Select Custom Account and click Set.
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 8. Enter the account credentials, as prompted.

 9. Once complete, navigate back to the Application Pools list.

 10. Select Decipher AppPool and click the Recycle button.

Recycling the IIS logs will log the user out of the current Decipher IDP session. If frequent recycling of 
the IIS logs is required, it is recommended that this is scheduled for outside of operating hours.

Secure the Decipher website with a Secure Sockets Layer (SSL) (production 
environments)
To secure your Decipher website to use an SSL certificate:

 1. Open Internet Information Services (IIS) Manager.

 2. On the left-hand pane, expand the Sites node and select Decipher.

 3. Under Edit Site in the right-hand pane, click Bindings.

The Site Bindings dialog displays.

 4. Click Add.

The Add Site Binding dialog displays.

 5. From the Type drop-down, select https.

 6. Add the host name of the Decipher Server to the Host name field.

 7. Select an SSL certificate.

The SSL certificate drop-down is populated with certificates from the personal certificate store 
on the local machine.

 8. Click OK to accept the changes.

 9. Navigate to the Decipher website and click Restart.

Any clients connecting to the Decipher website will have to trust the certificate that you selected in the 
above process. Self-signed certificates will need to be imported onto client machines, but it is more 
advisable to use a certificate from a certificate authority so that it is implicitly trusted by all clients.
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Check all Decipher services are running
Check that the necessary services exist and are running  – you can do this by typing services into the 
Windows search bar and checking these services:

 • Decipher Automated Client Manager
 • Decipher Licensing Service
 • Decipher Server 

This service will not run until the LocalSystem user has been given access to the database; or 
the Decipher Licensing Service has started.

 • Decipher Web SDK Service
 • RabbitMQ

See Troubleshooting if you encounter any issues starting the services.
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Activate sites and services for Decipher IDP
By default, IIS creates a website on port 80. If you want Decipher IDP to run on port 80, then this default 
web site must be disabled or moved to avoid it conflicting with Decipher. To do this:

 1. Open IIS and click the Sites folder in the Connections panel.

 2. Select Default Web Site and click Stop on the Actions > Manage Website panel.

 3. Select Decipher and click Start or Restart.

See Log on and set up Decipher IDP admin for next steps.

Enable machine learning training (optional)
Machine learning training can be switched on and off in the Decipher IDP user interface via Document 
types. However, it first needs to be configured in the SsiDataCaptureClient.exe.config file.

 1. Using Notepad++, open the SsiDataCaptureClient.exe.config file as an Admin. (The default location 
is C:\Program Files (x86)\Blue Prism\Decipher Automated Clients.)

 2. Find <add key="EnableModelTrainingML" value="false" /> and set the value to true.

 3. Save the changes to the config file. 

 4. Restart the Decipher Server Service.

For information on why machine learning is not enabled by default, see the Decipher IDP frequently asked 
questions.
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Update and encrypt database connection strings (optional)
For enhanced security, you can choose to encrypt your database connection settings. 

Update the connection string

 1. Using Notepad++, open the SsiServer.exe.config file. The default location is C:\Program Files 
(x86)\Blue Prism\Decipher Server\SsiServer.exe.config.

 2. Find connectionString and update the string with the name of the SQL database connection and 
user credentials. 

The existing connection string depends on whether the option to encrypt was selected when 
installing Decipher Server, and how the user was configured. The following are examples of 
typical connection strings:     

 • Data Source=.\SQLEXPRESS; Initial Catalog=DecipherServerDb; Integrated 
Security=True;

 • Data Source=.\SQLEXPRESS; Initial Catalog=DecipherServerDb; User 
Id=myUsername; Password =myPassword;

 • If already encrypted: 
enc:AQAAANCMnd8BFdERjHoAwE/Cl+sBAAAAardddLezc0amPmM328

 3. Save the changes to the config file.

 4. Restart the Decipher Server service.

Encrypt the connection string

 1. Launch the command prompt.

 2. Set the directory to the installation location, for example cd C:\Program Files (x86)\Blue 
Prism\Decipher Server.
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 3. Enter ssiserver -enc and press Enter. 

 4. Restart the Decipher Server service to test if the configuration is successful. If the service does not 
start, follow the Troubleshooting suggestions.

Reporting database configuration (optional)
If you have chosen to create a separate reporting database during the installation of the Decipher server, 
you can then copy across any existing reporting data from the Decipher database to the new reporting 
database.

 1. Using Notepad++, open the SsiServer.exe.config file. The default location is C:\Program Files 
(x86)\Blue Prism\Decipher Server\SsiServer.exe.config.

 2. Find WorkflowConfig and set the SyncOldDataToReportingDatabase value to True.

 3. Save the changes to the config file.

 4. Restart the Decipher Server service.

Restarting the server may take some time while the data is copied across to the reporting 
database.
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Install and configure the Natural Language Processing (NLP) 
plugin
The NLP plugin can be downloaded from the Decipher IDP page on the Blue Prism customer portal.

Install the NLP plugin
The NLP plugin, GPU, and the Decipher  automated client must be installed on the same machine.

An instructional video of the NLP plugin installation is available here.

Prerequisites
Ensure the following  before attempting to install the NLP plugin:

 • The specified minimum requirements have been met.
 • Decipher IDP is already installed.

To install the NLP plugin:

 1. Run the Decipher NLP Plugin installer.

 2. Click through the install wizard, following the on-screen instructions as prompted.

 3. On the End-User License Agreement screen, read the license agreement and, if you accept these 
terms, select I accept the terms in the License Agreement, then click Next.
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The Installing Decipher NLP Plugin screen displays.

 4. After the plugin has installed, click Next.

 5. On the Completed the Decipher NLP Plugin Setup Wizard screen, click Finish to exit the wizard.

The NLP plugin is installed to the following location: 
SSI_AUTOMATED_CLIENTS_ROOT_INSTALLATION_DIR\DataCaptureML\unstructured.
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Configure the NLP plugin
After you have successfully installed the NLP plugin, you will need to ensure that machine learning training 
is enabled in the SsiDataCaptureClient.exe.config file.

 1. Using a text editor, open the SsiDataCaptureClient.exe.config file, which is found in the 
Decipher Web install folder. (The default location is C:\Program Files (x86)\Blue 
Prism\Decipher Automated Clients\SsiDataCaptureClient.exe.config.)

 2. Find EnableModelTrainingML and change the value to true.

 3. Save the amended file.

See Natural Language Processing (NLP) plugin for details on how to configure and use the plugin in 
Decipher IDP.
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Verify SQL databases
After installation, the following databases should have been created – you can check in SQL Server 
Management Studio:

SQL Database Default Blue Prism Database Name

Blue Prism BluePrism

Decipher IDP DecipherServerDb

Decipher IDP reports DecipherServerDbReporting
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Silent install
Downloading and installing any of the Decipher IDP components, including by silent installation via 
command line, means that you accept the End User License Terms.

The Decipher Licensing Service, Decipher Server, Decipher Web Client, Decipher Automated Clients, 
Decipher Server Plugin, NLP Plugin, and a separate reporting database can be installed via the command 
line using the commands in the sections below:

Commands must be run from an elevated command prompt to perform silent install.

Decipher IDP component installation commands
Run the following command line arguments for either fresh install or upgrade:

Decipher Licensing Service

Fresh install

start /wait msiexec /i "Decipher Licensing Service.msi" /qn /norestart /log .\log.txt

Decipher Server

Fresh install

start /wait msiexec /i "Decipher Server 2.12.01070.msi" /qn /l .\install.txt SERVERPORT=12543 
DBNAME=DecipherServer DbSTORAGEPATH=C:\DecipherImageStore LICUSER=guest LICPASS=guest WINSERVICE=1 
DBSERVER="dec-ws2019-0\SQLEXPRESS" DBAUTHTYPE=1 DBUSER=<username> DBPASS=<password>

Upgrade

start /wait msiexec /i "Decipher Server 2.12.01070.msi" /qn /l .\install.txt

Decipher Web Client 

Fresh install

start /wait msiexec /i "Decipher Web Client 2.11.12150.msi" /qn /norestart /log .\log.txt 
INSTALLDIR="C:\Program Files (x86)\Blue Prism" WEBSITEPORT=80 SERVERIP=127.0.0.1 SERVERPORT=12543 
DBCONNSTR="Data Source=dec-ws2019-0\SQLEXPRESS;Initial Catalog=DecipherServerDb;User 
ID=<userid>;Password=<password>"

Upgrade

start /wait msiexec /i "Decipher Web Client 2.11.12150.msi" /qn /norestart /log .\log.txt
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Decipher Automated Clients

Fresh install

start /wait msiexec /i "Decipher Automated Clients 2.11.09201.msi" /qn /l .\log.txt 
InstallDir="C:\Program Files (x86)\Blue Prism\Decipher Automated Clients" ServerIP=127.0.0.1 
serverport=12543 serveruser=generaluser serverpass=user AddLocal=Common_Files,Server_Common_
Files,Data_Capture_Client,OCR_Client,Image_Processing_Client,Machine_Learning_
Module,Classification_Client,Export_Client

Upgrade

start /wait msiexec /i "Decipher Automated Clients 2.11.09201.msi" /qn /l .\log.txt

Decipher Server Plugin

Fresh install

start /wait msiexec /i "Decipher Server Plugin.msi" /qn /norestart /log .\log.txt

NLP Plugin

Fresh install

start /wait msiexec /i "Decipher NLP Plugin 2.11.11300.msi" /qn /l .\log.txt

Upgrade
As there is only one release of the NLP plugin, the upgrade command is not currently required.

Command line parameters

DBSERVER The name of the SQL server.

DBAUTHTYPE Authentication type – this can be:
 • 0 – Trusted (Windows Authentication)

This is the default and recommended for Decipher IDP.

 • 1 – SQL Authentication

DBUSER Username for the database. Only required for SQL authentication.

DBPASS Password for the database. Only required for SQL authentication.

DBNAME The name of the database. The default is DecipherServerDb.

SERVERPORT The port of the server. The default is 12543. This is required when installing 
the Decipher Web Client.

STORAGEPATH The image storage path. This is the location where the documents are 
stored after they have been processed. This can be any location, including 
OneDrive, SharePoint, or a local drive.

LICENSEKEY The license key for the Decipher software.
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WINSERVICE They type of install:
 • 0 – Install the server as a console application.
 • 1 – Install the server as service (default).

ENCRYPTION The encryption requirement for completed documents:
 • false – Completed documents are not encrypted (default).
 • true – All completed documents are encrypted. This is only necessary if 

the documents being processed are confidential.

ENCRYPTIONPWD The encryption password.

ENCRYPTEDPWD The encryption requirement for the encryption password:
 • 0 – The password will not be encrypted (default).
 • 1 – The password will be encrypted. 

LICUSER The RabbitMQ username when installing the Decipher Server.

LICPASS The RabbitMQ password when installing the Decipher Server.

DBCONNSTR The SQL application  database connection string when installing the 
Decipher Web Client.

INSTALLDIR The installation directory. This does not need to be passed if the default 
directory is used.

SQL_SERVER The SQL Server type when installing the Decipher Licensing Service. 

SQL_USERNAME The username for SQL Server Authentication when installing the Decipher 
Licensing Service. Required if SQL_AUTH_MODE is false.

SQL_PASSWORD The password for SQL Server Authentication when installing the Decipher 
Licensing Service. Required if SQL_AUTH_MODE is false.

SQL_DATABASE_
NAME

The SQL database name when installing the Decipher Licensing Service. 
The default is BluePrism.

SQL_AUTH_MODE The authentication mode when installing the Decipher Licensing Service. 
This can be:
 • true – Trusted (Windows Authentication)

This is the default and recommended for Decipher IDP.

 • false – SQL Authentication

RMQ_USERNAME The RabbitMQ username when installing the Decipher Licensing Service. 
The default is guest.

RMQ_PASSWORD The RabbitMQ password when installing the Decipher Licensing Service. 
The default is guest.

RMQ_HOST_NAME The RabbitMQ host name when installing the Decipher Licensing Service. 
The default is localhost.

RMQ_PORT The RabbitMQ port number when installing the Decipher Licensing Service. 
The default is  1572.

RMQ_QUEUE_NAME The RabbitMQ queue name when installing the Decipher Licensing Service, 
and must contain alphanumeric characters only. The default is 
DecipherLicensing.
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Where appropriate, each property is initialized with the default value if it is not specified on the command 
line.

Reporting database command line parameters
The following command line parameters can be used for the silent install of a separate reporting database 
on Decipher Server.

REPORTING Specifies if the reporting database is enabled or disabled. This can be:
 •  true
 •  false

The default for clean install is false.

REPORTSAMESVR Specifies if the reporting database should be created on the same SQL 
Server instance as the main database. This can be: 
 • true
 • false

The default is true.

REPDBSERVER The name of the SQL Server instance to be used for the reporting database.
 

REPDBAUTHTYPE The Authentication type for the reporting server. Works analogically to 
DBAUTHTYPE:
 • 0 – Windows Authentication

This is the default and recommended for Decipher IDP.

 • 1 – SQL Server Authentication

REPDBUSER The username for the reporting server. Required if REPDBAUTHTYPE is 1.

REPDBPASS The password for the reporting server. Required if REPDBAUTHTYPE is 1.

REPDBNAME The name of the reporting database. The default value is DBNAME 
appended with Reporting.
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Default file locations
The default locations of Decipher IDP’s configuration and log files are shown in the sections below.

Log file locations

The default log locations were updated with the release of Decipher IDP 2.1, but logs for existing 
installations upgrading from versions 1.2 or earlier were not changed. For details on how to re-
configure the log locations, see Upgrade Decipher IDP.         

Application Server

File 
type

Location

Config C:\Program Files (x86)\Blue Prism\Decipher Server\log4net.config

Logs C:\Windows\System32\config\systemprofile\AppData\Local\Decipher\Applicatio
nServer\Logs

Classification

File type Location

Config C:\Program Files (x86)\Blue Prism\Decipher Automated 
Clients\SsiClassificationClient.exe.config

Logs C:\Users\Public\Blue Prism\ClassificationClient\Logs

For systems using 1.2 or earlier:                         
C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue 
Prism\ClassificationClient\Logs

Capture

File type Location

Config C:\Program Files (x86)\Blue Prism\Decipher Automated 
Clients\SsiDataCaptureClient.exe.config

Logs C:\Users\Public\Blue Prism\DataCaptureClient\Logs

For systems using 1.2 or earlier:                         
C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue 
Prism\DataCaptureClient\Logs

Export

File type Location

Config C:\Program Files (x86)\Blue Prism\Decipher Automated 
Clients\SsiExportClient.exe.config
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File type Location

Logs C:\Users\Public\Blue Prism\ExportClient\Logs

For systems using 1.2 or earlier:                         
C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue 
Prism\ExportClient\Logs

Image Processing

File type Location

Config C:\Program Files (x86)\Blue Prism\Decipher Automated 
Clients\SsiImageProcessingClient.exe.config

Logs C:\Users\Public\Blue Prism\ImageProcessingClient\Logs

For systems using 1.2 or earlier:                         
C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue 
Prism\ImageProcessingClient\Logs

OCR

File type Location

Config C:\Program Files (x86)\Blue Prism\Decipher Automated 
Clients\SsiOcrClient.exe.config

Logs C:\Users\Public\Blue Prism\OcrClient\Logs

For systems using 1.2 or earlier:                         

 C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue 
Prism\OcrClient\Logs

Web Client

File type Location

Config C:\Program Files (x86)\Blue Prism\Decipher Web\NLog.config

Logs C:\Users\Public\Blue Prism\DecipherWebServer\Logs

For systems using 1.2 or earlier:                         
C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue 
Prism\DecipherWebServer\Logs

Configuration file locations

RabbitMQ

File type Location

Config N/A

Logs %appdata%\RabbitMQ\log\
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Web installer

File type Location

Config N/A

Logs %temp% - there are 4 log files, whose names start with Blue Prism_Invoices_Web_Client_
 
C:\Users\{username}\AppData\Local\Temp

Web SDK Service/SDKWrapper

File type Location

Config C:\Program Files (x86)\Blue Prism\Decipher Web SDK 
Service\SdkWrapper\Ssi.SdkWrapper.exe.config

Logs C:\Users\Public\Blue Prism\SdkService\Logs

C:\Users\Public\Blue Prism\SdkWrapper\Logs

For systems using 1.2 or earlier:                         

If started under NetworkService (default): 
C:\Windows\ServiceProfiles\NetworkService\AppData\Local\Blue Prism 

If started under LocalSystem (deprecated): 
C:\Windows\SysWOW64\config\systemprofile\AppData\Local\Blue 
Prism\SDKWrapper\Logs
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